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2, 4% MPLAB IDE [f) Debugger>Run Zhfigak Run K 4x. MCD2
¥ VPPIMCLR DLV HFBRZAT. Hbek A ZFIF 51217, EEIRE
FPUE R IA B ATAT 7 P AR 25 748 1R T st
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B, WS AN AR CPU PR, IR L8 SR d5 2838 5 1A R ke b
17,
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* MCLR/VPP# 3L FH /E S FE.
o R H T g RE (LVP) 8 5 1]
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o — ok R HERMCD 21 R 24l T
o LGl H H bR S AR AR OR B
o FRITATAf A 10 iy Mk 358 20 9 O B 1 A TR,

o TR PICI8FXXXX I R 1 HEAR AN v . I FHARE P v] LIS 51 HEAK,
THASBE MR 7 s B CALL FRE 3R 11, DR o MCD2E K75 W7 s i
6 5T HERR.
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4§ F Programmer>Program LK 4mfEse 415, £ MPLAB IDE
HE LR TR A7 2R N < ], IXFE MCD2(MPLAB ICD2)¥5 HU 4w 2 H br
FIACHSFIRC & A7 (F1 EEPROM #idfs, Wi R AT $EftIFik %), kAT And K
AP, PR T, MCD2(MPLAB ICD2) H fig# il MCLR £ K 547
AR S HbRas e, WS AR RS, TSN AEBAEAS.

MCD2(MPLAB ICD2){#i ] ICSP %} HAriE AT e, e i A 75 2
I HACERER(1) Fr g AR R b g B, BARARRS AR, BT 1M i 2 Al RE AN
R

R A MCD2 RG> 51 IR 25 PRI 22 /5 28— M7k,
XSG T TG R 4K VPP,PGC Fll PGD T8z, AN )
F R REB AL

H_E IPNE
2.1 vl
X—# 4 id MPLAB IDE #{:F1 MCD2(MPLAB ICD2) /i ], Ff-¥5
R PR R T RN HERE R _E R, 55 =R G ] MCD2 — 2B fd .
TELRELARIR G 200, B A R A R 3 2.3 15 F1 2.5 5T T L

H.
2.2 BX
N B i 1A 1 A A

+ MCD2(MPLAB ICD2) & 4i 41 i,

£ 4MCD2(MPLAB ICD2)k 22 Fl it & MPLAB IDE
o N HLYE

o R WEIRE

+ F % MCD2(MPLAB ICD2)JT A i i

2.3 MCD2 RS A B
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BR T MCD2 i, i 752 N
* MPLAB IDE# (it A6.205 5 ) — 22e/EPCHL L, HISk4EHIMCD2.
* RS-2328USBHLZi — 1EH:MCD2Z|PCI1)H N ELUSBI.

R ANEIER: USB W4, HPI%%: T MPLAB IDE #F IR &
] USB BXsh It & 5¢ ik

o WP OB — EREMCD23)E S IR

o WHRAREL H BRI — FREERST i A TR RE ST IRPIC HL iy HL Ak
B 1(RIMCD2). /A% MMPLAB IDEFIMCD2() #3147 5{ USBIE 1A 75 2
HbRERER ey, (HMCD2ANIERL S HARBCE A GEAE b — MRS T
1E.

VER: 7EEH USB HLZGHT, 7E 2% MPLAB IDE 3K {4 i AN BRI e i %,

o HJFIERLSE — XITMCD2FN H Frbi it .
2.4 $PXYMCD2R %3 MABLEMPLAB IDE

B4 MPLAB IDE A, B /GBS 5071 MPLAB IDE R4 7
(MP6xxxx.exe, ' 6xxxx %7~ MPLAB IDE it 4). MPLAB IDE 7] LA
M Microchip 5t s AL G 3R AT
2.4.1 BILEW

St MPLAB IDE, #%)5 M MPLAB IDE R[] DriversXX {3 %
%¢ USB BK5h. B VY F"USB “ed v, A RS-232 i, ¥
#%E$:5] MCD2 Hil PC #L.

ER: AE USB F RS-232 #Bi%E#:5] MCD2 .

2.4.2 FFi4 MPLAB IDE
1E44¢5¢ MPLAB IDE #4F )5, AR AT —Rh 5k 8 8he
o VEFE FFdE>F2/F>Microchip MPLAB IDE>MPLAB IDE.
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« XWiFMPLAB IDEE|#x

BERE: LT HIMPLAB IDE#AFK B 245 5, AT AT
“MPLAB v6.xxPRIH 5 R,
EF%MPLAB IDE 752k 55 1)
5 {EMPLAB IDE 2285 4% 114 5 MPLAB IDE.txtf¥]
Readme 1.
0] AT & 5 T"MPLAB ICD25: 5 f{IReadme 3 14

» }ITMPLAB IDE %3545 F\dlls 7 H 3% Fffimplab.exe.
73 3IMPLAB IDEJS, ‘&7 2 JMCD2(MPLAB ICD2) 31T HL
1. EFEMCD2(MPLAB ICD2)/JT S H# IIPIC B F.
2. W EMCD2(MPLAB ICD2)1F Jy 24w i 25
3. [l EMCD2(MPLAB ICD2)[#JRS-232ikUSBH: .
2.4.3 EHERMF

1 F 2% £F & #% % 1§ #£ Confiqure>Select Device K % #
MCD2(MPLAB ICD2)Z ik [ #514. MCD2(MPLAB ICD2) i S £ 1) 254
231E Microchip T HSFF R E4%% MPLAB ICD2 5315 — A4 kT Kb,
ACFERIA A — AT EbR. BT AR SRR AN S T DA%, (He
LR, FTREAE S T2 TAEAHE A LAk MCD2 15 AL .
2.4.4 %% MPLAB ICD2 fEARIR T A

1% £ Debugger>Select Tool>MPLAB ICD2 ¥ MPLAB ICD2 1£ Jy i
RTH., —HXANTHEERE, iR MPLAB IDE T H4A&S R
PESY. AR, s O SFTIF, 0T ICD AREFIE WS B & BoRTE
MPLAB ICD2 #3252 1.

FERE: MPLAB ICD2 BE v LIE AR T H, ta] DIVE b i s, (HANEE
[i] s 326 % .
2.45 EEEO
B3 Debugger>Settings Il AR, £ USB #2184 % RS-232 i
HIEAfIK) COM .
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2.5 N HYE
E X MCD2(MPLAB ICD2)F1 H FRHRA VF 2 IR E, T I IX L6000 & 1) %
ot

éﬁ%wm A, MCD21] LAMPCHIR AL HL. (H A0 2225 H Frfi 4 it
. ‘éﬂiﬁﬁ RS-23234: % 2| PCHLIN, MCD24AZ5HE — AN 4M il HL .

« MCD2T—AH O HLIEET, & rT OB/ H bR HESV L $2 it
— 5 1 HL, 5t AT TA200mA.,

« MCD2AGeid ik H brpi it .
o FEZS BAROIN L T, R 5645 MC D2 H.
2.5.1 HMCD2% B pniR it B B i) _b EB G
AR T PR 1EMCD245 H AR iR . 33X NI E I RV FEBY, B
200mAH I F# .
1. Z5MCD2HHE. ANEL H bt i,
JHZIMPLAB IDEG.xX.
YEMPLAB IDE[J A5, kP Connect.
E5MCD2 il 5, EFDebugger>Settings.
eV EXHEHES, ST diPowerbr%s, fifiil”Power target circuit from
MPLAB ICD2”#{ik . 550K

oD

o

R Wk Settings* if HE Status bR A (ATAA] 2 ML R Al ek
AT REANREBERR FIgm L 5. IXH 77 2200 2 A ke . 95 28 e
SNTE AL T B DR 215 B
2.5.2 HBE#IRE — AL B YE B _E R
A X AN Sk h H bsi i ke [ S sk b X IX ML,
H s HJs A] LLJE 2-5V, B/ Al LLEE MPLAB ICD2 $24L i v . A& PIC
B MU T DU XA B4 B A P e 31 L
1. Z5MCD2NHE. ANEL: H bt fih .
2. JiZIMPLAB IDEG.xX.
3. {EMPLAB IDEMJHIAZRH K, kP Connect.
4. {F5MCD2# vl )5, EHDebugger>Settings.
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5. e EMIGHES, SidiPowerbr%s, ffii\”Power target circuit from
MPLAB ICD2” %A #ik . ridiOK.
6. 4 HFsHRZ LW, S5k PDebugger>Connect.

R R Settings XFiEHE Status FrESAF: AT HME R AGE L, %
nBEANREERER A G AR O . X TR 2 R bR Y. AR AR A A
NS B LASRAS B 245 B
26 B WEIRSE
X —FE R R R T 6 MCD2 R N, 2L Th e RISk sk
AT T AA. X524 T MCD2 24 [ fad s 4.
2.6.1 RE AN FEILEIRN
PP UEAE FCVF SR 5E B A R G 2 228 T
o it B A TG HE(Configure>Configuration Bits) —7FPICAbHi 2% ik £
BOE AL, X T IX LRI e HE M40, n] DL XA Bs T R e vk
— MR T

VER: BCEA A ARG h g iR e, DU A RS HE 3
XA, RERE G TR, OB AL BRI A RS TR E AR
o HifEbR%E, ICDT B XHEHE(Debugger>Settings il
Programmer>Settings) — % & 4 FLIk T (L BAE 0 2%, PRS-
ASJEH] 1D, FIgwPEEI, EEERR). ARG EIDA, v LATE
Configure>ID Memory % 1 HE H 4 B 5 4 Fi 118

o HIJEFRZE, ICD B E X 1 HE(Debugger>Setting sk
Programmer>Settings)— & AtMPLAB ICD2F1 H 5 HLEAE, Witk
MPLAB ICD2i%E#: T —AN i (5V, i m1200mA), L £ Power the target
from the MPLAB ICD2".

R& AL, ICD ® E X 1§ HE (Debugger>Settings %
Programmer>Settings) — k& T 76 F R AT A BhEBAE, 38 AT LLAEIX AN
T HE A 2B A R B AN SO, IR BT LB B A B B AT R,
38 Microchip A S H A& I 1) 8.

26.2 flg—AILE
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I i B B — AN B LRER vk 2% Project>Project Wizard 7 T
FEM SRR, —ASH TR T TR S TR R, W
WA IS NIRRT, SO BSOS B TR RN T L 5
AR S AT XA R 2 4R
263 BT

G TR )5, %% Project>Build All g N, XK A x4
N 1 H AnARS, T MCD2 45 H b .

2.7 BYE: MCD2 FF ki

il MCD2 )T A i R AL 46 DY AN P 3R

1. ffH] MPLAB ICD2 124 a8 T A, K i AR 4 21 H Az o
%

2. AN R

3. BUEMEy, A TR, REES B TAE, BRI ER
1517,

4. EFE MPLAB ICD2 10 T g as, SRJ5XS HAx dsfhgm i,

2.7.1 YERAREEXT H b b B 2R G 1R

YRR B, B N AU 4 FE 2] MPLAB ICD2, ] LAJ4 R T 25 B34 T

1. 1&+¢ Debugger>Settings, A J5 MR FAREE, R AN H % BT
FEAif 2 (PR UG TN 45 ik

2. %E#& Configure>Configuration Bits, & FMN L & 7.

3. %Ff Debugger>Program.

2.7.2 RN

BESIPAT AR, Al e R D

1. FTIRUERE P OO TRE D SO 44 B - Eile>Open) sifs 7 A+ fifi
% M (View>ProgramMemory) ] -1 il 5.

2. 1%k Debugger>Run(alfdi T HAF: RUN KbR) AAEEEK — HigiTH
P Al 31— AWy s, AL BE 45 8 o ¢ Debugger>Halt(a% s T H A
Halt $24) # k.
1%+% Debugger>Breakpoints 4 W i f5 & 7 &, BRI P AT BLAS
B WT SRR A a4k AT A4 B, P Set Break Point. MCD2
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— AR E — N A
Wb BEES M 12 5, AR AT DL CLBOD B AT AT D,
Debugger>Step Into (il 25 T ELA Step Into 24H). ERFRHL 2
J AL B 2%

FER: UPAT IO, A WG LT LR R R TEVERE N AT LA
AR TR R E W, SRS ISAT R, AT T TR,
273 BHARNAREIER HEX X4
Fs G H bR I HEX SO, o] L% IR R 15 BRI AT
1. FTIFUERE P (O0s TRE T 1) SCE 44 544§ Eile>Open).
2. XA AR Y A L
3. {#iJf] Project>Build All & HEX 3014
4. %EF$ Debugger>Program ¥ 5 #i1f HEX S 4ufe 2 H Ands fF.
2.7.4 SERNH: EH MCD2 1E A miEES

— H P s TGRSR, IF BRI IEAT T, ARt il A
TR RE AT gL T X T B A8 O B 28 Js0gt ol LA 7

R MCD2 BEnT AR Rl T, ST DA g ds. (HANEL R I
EELE

B4, M Debugger>Select Tool % 'E /i 2 F)"None”.

RJA, EFH Programmer>Select Programmer>MPLAB ICD2 %
MCD2 ¥ & A it ds.— HIXAS T HPEE £, a2 H MPLAB IDE T
HAK &0 WoRgmFE AR IE 0. [FII, i o &4 JF, 46 MPLAB
ICD2 #%_F4x 7R 5 MCD2 HRAS I AR 3¢ 145 L.

IRAE N H g TR, DAMERT A PR e O A, I B YRR 7 v i e
SCHIBC B AL G FE 2 H bR 281

Ui FEAE T (B A7 i 23 X A ATV ) /T LAZE. Programmer>Settings X i
HE 1) i A AR 25T I

BC B A7 K e B SC AR o SO AT e E . e AT A BLaE i E A
Configuration>Configuration Bit X} i F-5hik £,

WIRAS I, 7 LL%k$E Configure>ID Memory K% & 1D ;.
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m=%F MCD23iERg

31 4
XS E 2 A0 IR med-ledl.asm A28 FF kN fai o TR
B, XAMBIFELE MCD2 197 S L 226 AL 1 MCD-DEMO 4 F S5 Sk vh
A DL R, AL A% MCD-DEMO ¥ s Bk S8l PIC16F87X 1)
TKAT.
32 B
IXFETE o5 (M1
o WHEIIEE
o BT TR S
. E LR
« BIEHEXSC A
o WEIRIER
o WHEHRR
o ARG
» 1z4Tmcd-led1
+ Hixmcd-ledl
. GnfE
» mcd-led1 1 F2 ¢ FIYEACHS

3.3 BEHNBL

TETFURIX BEFR T 2 0, $% AR 520 2.3 15 42 2.5 19 [ 2D IR ¥ L A0
MPLAB IDE #ff. {fEiX & e ) — Sy Enl fe e s —smrh o 4w
BT

— HJ53);, MPLAB IDE 5 [ W i% /s an & 3-1.
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W MPLABIDEVE.30 =10] x|

Fle Edit Wiew Project Debugger Programmer Tools  Configure  Window  Help
NEFH| sl 252 || ®
i Untitled Workspace U =] 4|

3.3.1 FEFEIHFIF KK

R

1. %#f Configure>Select Device.

2. FEBFEPEXTUGHE, MEs{151RMEIL$E PICI6F877A. 7 Microchip T.
HZFR B35 MPLAB ICD2 HAT B AR Y. %k R (6.

3. kil OK.

P MCD2 1E R TR AS:

1. %% Debugger>Select Tool>MPLAB ICD2. it 4Ly b2 Bornf
PEAT I AL PR IE . (RIS, ST RIS

EHE: WK MPLAB IDE 7£ )3 8 BHA K% H2 8] MCD2,(H X USB 115,

1 COML it COM P FTTTI S, 54 SUVFSRIC R85 51103
i

2. %E# Debugger>Settings, HHIHFRZ. HEFE USB 5 COM i [ /)4E
3. WHRAHE MCD2 HEER:, fMdikR&H%, &P Automatically

connect at startup” & 215 B 2 ¥ ok S M
4. il OK.

5. %% Debugger>Connect %% MCD2.
3.3.2 HEH MCD2 EHEIERL)

45 MPLAB IDE [PJRRAS LA IIERE, Ston— 45 B wos [/
FLHH. MPLAB IDE ¥ H 3l 428 (I [l . S8 1l A Gt P i 7
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FIGURE 3-2: UPDATING MPLAB ICD 2 FIRMWARE
DIALOG

ICDwfarm0030: ICD2 iz about bo download a new operating system. 1f
MPLAR iz just starting, it will appear to "hang"' &t the splash screen. Flease
be patient. MPLAB will finizh it's intidlization after the 05 iz downloaded.
[Mate: ¥'ou may wish to select ta igrane this warning in the future. ]

[~ Dran't display this warring again

0K |

AW, AT MPLAB ICD2 Al Fl FANF & 511K PIC AL, 4

DI AR 1) PIC 55 AL B AT BE H X AN RS HE.

(] A2 Fy DL R T ) 20 3R B B

1. %% Debugger>Download ICD2 Operating System. i%£$f ICD2
SRR HE S FT T

2. N b B A b ok R N ) [ SO SO A A A
icdxxxxxx.hex, H 47 xxxxxx M A 5. 5T MPLAB IDE $2 L &5 i AR
({5 BT LA E README SCfFEk MPLAB ICD2.txt AR 4 E R PIC
L e N 3

3. Aiili Open. MPLAB IDE ¥ NEUHTH#:4E &£ 4: 3] MCD2.

34 B IERE

FEIXAN THRET, MPASM J1- g S8 2344t 1.

1. %Ff Project>Project Wizard >Rk & 7 55—~ TFE.

2. AT R AN P XEHE, PICLI6F877A NZ gk,

3. RLFEAT R I TN —AXIEHE, BE MPASM ERNiE T T A,
7t "Active Toolsuite” T 7 ¥ & 1 1% # "Microchip MPASM
Toolsuite”. i iA MPASM F1 MPLINK #& & 7 MPLAB
IDE\MCHIP_Tools SCAEJE AR N il 04T 314 1. MPASM [ 5 & £
mpasmwin.exe,MPLINK ) $5 7 £l| mplink.exe.
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fiProject Wizard L x|

Step Two: i
Select a language toolsuite EE/’-@

Active Toaolsuite: ticrochip MPASE Toolzuite

— Toolsuite Contents

c:t Linker p

— Location

ID:'\F'logram Files'MFPLAE IDESMCHIP_T ools\MPASMWIN EXE Browse... |
Help! My Suite lsn't Listed! I I Show all installed toolsuites

< t—F @ [F—Fm ] i | e |

|
PG TR SO N 2 1) 3

SO AT AR DUS AN, T IX AN f, %4 MCD-LED1.ASM (i %%
¥ OGAE) MCD-DEMO g B2 591 SCAF 2 52 i B A M A A AR H sl e |
J& AT TE P SCFRFI SO IR, I B 44 4 9SO

x|

Step Four: Eﬁ
#dd any existing files your project :

mod-adl.asm =

meod-epm1.asm _I M
mcd-inbz. asm

mcd-lcdl . asm Remove I
mcd-lcd2. asm

MCD-LCD2.COD

MCD-LCD2.ERR

MCD-LCD2.HE —
MCD-LCD2LST

mcd-led].COD

med-led] err _ILI Check the bow to copw the file to the
I 4 project directany

IRREEEEDDEDE

< t—#m [F—%w > i | =g |

Rt MCD-LEDL1.ASM ik e, X5 it ADD>>H4 e s i 247 1 1)
THIAR.
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Projectwizard x|

. Summary

Click 'Finizh' to create the project with these parameters.

Project Parameters
Device: FICTEFE77A,

Toolsuite:  Microchip MPASK Toolsuite
File: E:Ncugmeutmed-led].mcp

A new workepace will be created, and the new project added
to that workspace.

B | e |
35 AFETLHE
B TS5, MPLAB IDE S0 X £ B PR e % H S E
THREE .

TR DNz N E AR

i mcd-led1.ma o [=[
=l mcd-led1.micp

- Source Files

i lmed-ledl.asm

- Header Files

i Ohject Files

Library Files

o Linker Scripks

WREHER, XATUFIHMRNE TEE D . ¥
F”Source Files”m"Linker Scripts” s scy:. SR —A> 4, A LA
Seik e, ARG s PR, SR 5 S A
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3.6 fI#E HEX XX
BRI — > HEX SCfF, 7%£4% Project>Build All 50 fE TF2% [
B TR T B AU EEI  H )2  EEREBuild All”. MPASM I
g 2 Lh.asm SCHAH A 4 AR A .hex SCHE-.
oy v 7 1 N A B R

[Cr— Lo

Fuild |Find in Files | MPL&E ICD 2|

Deleting intermediary filez... done.

Executing: “D:“Program Files\MPLAE IDEMCHIF Tools\MPASMWIN. EXE"
Messgaze [302] E:\CEQMCIMWMCD-LEDI. ASM 22 : Register in operand not
Loaded E:'\cxagmoumcd-ledl. COD

EUILD STUCCEEDED: 3at Jul 03 19:13:52 2004

3.7 WEIRREI
3.7.1 EEM
oK BCE 7, % Configure>Configuration Bits. i i
ti"Settings” 41 BL (1) SCAH] LA AT THEATAE . AEXAS RS HE S, X)X
TEAE, T A ECCE AL N A% R
» Oscillator — XT(X /&4 %MCD-DEMO. 4 H4i F 2L e 10 H ARAR, kAT
AH Y. )2 5
* Power Up Timer - Enabled
* Brown Out Detect - Disabled
* Watchdog Timer - Disabled
* Low Voltage Programming - Disabled
« Background Debug — Enabled (1% K G £ 2k e k. 8 fEiE £
MPLAB ICD21F 4 2 ay il s I, X T2y A 3l fE.)
L BT A G A A K A
3.7.2 HFEEIR
FVE g AR, £ Debugger>Settings X Al Program bR
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PLAB ICD 2 Settings Jed 4
Status I Communication I Limitations
Fower Frogram I Yerszions I Warnings I

¥ Freeze oniHall
¥ Eraze all before Frogram

|' Program Optionz

[~ EEFPROM
D
[~ | Extermal

— Program Memorny Addresses - — Extermal Memon Addiesess —
[hex] [hiex]

Start ||:|H|:| Start I
End ||:|:-:'|EFF End |

Full Range | EullHange |

o IEPAE RS N 1Z " Program” ik, “EEPROM " II"ID" ANk, 244
MCD21E 4 AR I, FC B — B g R, Bl B R AERE gk b ok 2K
.

o FEIPA7 it s Mot (GRS 4 M R R k) FH R B2 B R P A7 as Ve L, e
Kk, gmiEaiicss. mdiFull Range B B AL Tk rh &4 ml (AL ds KR
JPATAti A I Lo PR v SRR A7 g 1) &5 A Hb B A T I 38, DUOR B 23 )
AEMCD2URIREE 7. U FHMCD21E A A5 I, FEFP AN et b b
Fid.

3.8 WEHEHI IR

YEFFHA IR AT, #1IA MCD-DEMO /st N 3T 5 &
o B2k I3,J41E PEXT OSCik I

o Bk S14:#FON.

o YRR AL

3.9 BN ARG
23
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1%+ Debugger>Program ¥ MCD-LED1.hex %if%%] MCD-DEMO i/~
¥ ¥ PIC16F877A.

R RS B shga e B RE A7 g N 10225 B T MCD2 111
W, IR g AL S H bR PIC B ML, LS MCD2 (74
WRAE .
YR FE ] RETT B L b, EgmEi Rk, it HEHER) MPLAB ICD2 £
SRR EAE AT B, AR ESE R, REHE R 1% W& 3-10 .
mouwpet = E

Build | Find in Files MFLAS ICD 2 |

««Programming Debug Vector =
.o Programming Configuration Bits
Werifving..
. Program Memorsy
.. Debug Executive
.. Debug Vector
.. Werify Succeeded
.. Programming Configuration Bitz
. Configz Memory
.o Programming succeeded
MPLAE ICD 2 Ready

< | BN
3.10 i#4T MCD-LED1

MCD2 1] L DL SE I 5l 5P B U AT

« {EMPLAB IDEfJizf7#i = o' MCD-DEMOiH 7~ 4t _E IPIC16F877A¥ s
A7 AE S,

o TEACBRERME LS SR D ATk B U7 ).

A AT DL 5 FH AR R A 1 PR ).

VIR T HA A VIR T HA A
247 S HOLHAT 0
Wk i 5L B
24
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FFUR AR
1. 47 JF MCD-LEDl.asm 3 (#£ TR & 11 B XUk 30 #F 44 5 A 1)
File>Open).
1EFf Debugger>Run (2 & 7 T HA% RUN 4%4)
AEHNR b, g LED it shid #2 R4S,
1 $% Debugger>Halt(k 5 5 T HAS HALT #400) b 1R 84T
¥E$E Debugger>Reset &1 Fi 7.

S R

3.11 ik MCD-LED1

N TH AT A — TR AR BE R 1 MCD-LEDL R 1) TAE.

* DEMOJF K A A % A ON.

« DEMO#R {1437 77 sUBk 2k v B AT

s PR REHRES FERT TEAER.

BOWER T AL I SORIRA, AT DAZERE P AH O A 1 T R

1. M MCD-LED1.asm Hik th 8eRE s il & 7r 23 W sl it 1 i —A47 4
btfss  flag,0 AR AT, SN BERIIEIR AL

2. SR, SR SRR,

3. Mk $E Set Break Point. iX—47HLAEMbRIC A T (L0011
B {5 1-4r12). an B F .

4. %H Debugger>Run(ml il THEAF: RUN #224) PASZR A S XIZ 4T
FEF.

YR PAT BT 2 B EAT I, B A bR R RIsAT. AR, IR S

k.

5. i%¥$¢ Debugger>Halt(ak & T HA I HALT #2400k iEFE .
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I E:\ cxgmicuy n'n:d Iedl asm I ] i
mownwf  trisc BB R EE IS T j
bof status, b SEEHI M E TR
movlu 0Olh 0000000 1B5GIEY
mowwf portco ,ﬁEHW%ﬁEJﬁEﬁﬁ%&
bsf flag,0 SEERBRGNEL, BRI LED .

bof status, 0 SEleciEEi
loop btfss status,0 L AR R, 2 LS CIRS

goto loopl PRl | ik
comf  flag,l sFLAGHIBTTOfE MRS IEERE
@ loopl btfss flag, 0 P oy R 13 2 M
goto loopE PR )iz T e o
vif rnrte 0 SEM A REim O nEr R =S e« SRR _Ij
3

6. BEHANFLE, %t Debugger>Reset. #4354 N i Wonili— A4k
i k.

7. AT ASHE B PRI R P AT FLAG r e (M40, 1%
¥ View>Watch. MEAHEHEE Watch 1 &9 4T7F. A Symbol
IR IERlag”, ARG AdiiEH”Add Symbol”.flag #47 in %
ML E D s,

CIES _loix]
£dd SFR ”.&DEDND v| .f-‘«ddSymbuI"flag ~|

Addres= | Symbol Nate I Value I
aozs flag as

['wiatch1 ‘waich2| Watch 3| wiatch 4|

8. HULHUTHLR, %+t Debugger>Step (a4 tith T HF: STEP #44H).
9. FEMELH Lk & 27 A7 45 FLAG 1A
10. ik FFile>Save 17 1.
11. #EF¥Project>Build ALL F TR, — 45/ B S Ry ol o o7
A AR 20, MCD24AZ5 4 . FT A
26

PDF L "pdfFactory Pro™ i Ff A www. fineprint.com.cn



http://www.pic16.com
http://www.fineprint.com.cn

PIC16-MCD2 1 F i B 45 http://www.pic16.com
12. ik #¢Debugger>Program ®= i fe. *iMPLAB ICD2X] 1 HE t
7K'...Programming succeeded’, F£ ¥ it i] LA K E N IS 4T AR K.
13. 7EZ BB E W AT s A, £ Remove Break Point.
14. #$Debugger>Run 2 I 17 E LB, ek By 28 R il As 8
LED I B RI11H.
XUHEEE IR H A — AR, SR, SERRIAES il RES AT £ 1)
. {fFHMCD2FMIMPLAB IDETRRTIfE, 7 ) 1 R IS 51X 88 )

H

.

3.12 R
YR I RIS AT, N e PIC LR, Y
HATIX—2D 0], B MCD2 {3 B I Y R kg H .
XN REAT e, n] DAL IR A R
1. %+ Debugger>Select Tool>none x4 MPLAB ICD2 1F Jy ik L.
H
2. 1t Programmer>Select S HH i $: MPLAB ICD2 1 4 i f 4.
3. ff Programming>Settings F£FAngs ik & H T e 113 4L
4. ¥ Programmer>Program.
PiIfE MCD2 #fie A7 91217 HARMCD2 thn] LI HARWIIT, #Edk$ 5 Ar
Y2 5, N ZIEAT).

SmE  USB REMTS

4.1 +48
X4 T AP ANR Windows #4E 2 48 USB SR 522k (475, X 4L R
SRR
* Windows 98/ME
* Windows 2000
* Windows XP

W8 THNR I IKS), KB F|USB ) #. WindowsZ: 231 K 4
FEEINMUSBIKS)). IXANIRENREAREAEMCD2 | TAE. an s3] 1 ) &,
AJ DAY B R 4 45 5 2%k A A Microchip USBIREN # 41 /EUSB# 4% .
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FR—NRAPIUSBR &S A I AE I e T WERRIXAN R4, M
ek EER. AR AR B AR R R Rk sl NI DR,

Kl4-1 875 1 A R C A
FIGURE 4-1: DEVICE MANAGER

% Sound, video and garne conkrolers
-7 Storage devics

-- Systern devices

=82 Universal Senal Bus controllers

Intel 82371AB/EE PCl to USE Universal Host Contialle
E> Microchip MPLAE ICD 2 Firrmware Client
“.gg USBE Root Hub

4.2 WINDOWS 98 F1 WINDOWS ME %3¢
421 BE1

MUK — BN USB B# %3] Windows 98/ME RZEHf, —/Nxif
TAES LR RO T — D H B e . R rT e Bl — X IRHE S R
JH P B 26 A0 128 1A A e N7 BB R

LT L2 S, 2 TR S I B ) XA i b
iAoy

422 WE?2
BN S B IE R IKS). Rk T, AR5 RN

VER: WORAE TP B B KILEGR T INF 2R3 & 3K 5 S 1,
FAOLIR 2, WA BRI a7 N — BRIV AZ ) ] B A SR,
XN R A 2 L FRAE AN TR AE SC VR FETT AR FILINF S0
fEfe. — FIXABRARPOEHE, sl OK gk 2.

423 B3
TXANKTUEAE SCVF T 48 2 W6 L AT LA 7 e 4% BT g 2 SO, WA B
A HGEHERS AL, B TR IREAE I —A>. e g, A&
BEN B IR B SCA R A (PT LB AR, A 0 Y AT ). A5
28
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W 2N, XA ERAR I 1o
C:\Program Files\MPLAB IDE\Drivers98\ICD2_USB
XA FE AR BB T S A
* ICD2W98.INF
* ICD2W98.SYS
* ICD2W98L.SYS
—HgtetdRE, Rt
FIGURE 4-4: WINDOWS 98/ME NEW HARDWARE
WIZARD - 3

Add New Hardware Wizard

‘windows will eearch for new divers inits diwer database
ah your hard drive, and in any of the following selected
locations. Click Mest to start the zearch.

™ Floppy disk drives
[~ CO-ROM drive
[ Microsoft windorss Update

¥ Specify a Jocation:
IC:\F‘rogram Files\MPLAB IDE"\DriverSSEI\ICDZ_UEj

< Back Mest » Carcel

424 BB 4
I —ANGHEHE N % 77 "Microchip MPLAB ICD2 Firmware Loader”

WAk 2, IF WO Z BT POE R, s N —2b.
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FIGURE 4-5: WINDOWS 98/ME NEW HARDWARE
WIZARD - 4

Add Have 1 sadnss 'Wimsad

LA R RN NI B TEEEY TETE RN REIWH

b zackie FFLAE ICC 2 Firwwsic _azoce

WA ConIs it 1w penci by role 1he bergk 40 e o ks
dever Ckk Dachbc o ec: scifer wd we, oiclick e
b ewhioLr

Lisagtiae ol Ji-n,

= Ceh ragramn [ b RP = ) IDCA R JONCT 2

Laorial

425 HBS

5 —ANWHEHES: S s"Microchip MPLAB ICD2 Firmware Loader”
Wezde, miioe gl Wwde.

X MPLAB ICD2 & X ERINE]. RGN 1% H 5h2# A\ MPLAB ICD2
USB % /33K a0, 78T IR HETE K 55— MR AT, 15488 5 5 =P A A
(P42
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FIGURE 4-6: WINDOWS 98/ME NEW HARDWARE
WIZARD -5
Add Mew Hardware Wizard I

% Mizrachip MPLAB ICD 2 Firmware Loader

Windows haz finished instaling the software that your new
hardware device requires.

¢ Back Cancel

4.3 WINDOWS 2000 %3%

24 MPLAB ICD2 7 WINDOWS 2000 %45 55— ddi A USB Itf,
TR B R 34T, DA IEAf (1) 2B 2 IR B)).
431 BB 1

B — UK — AN USB W 44123 Windows 2000 &4Gch, —/Nxtg
HESs IR /s REGE I T —ANBr A £, A1 m) B B — o i A 5 Uk FH
FAVRE % 5O PR L A4 A 37 5 R

XL TEAE I 2 5, & WoRT R IR A a) SR HE. i 2P
Ak e,
432 BB 2

TN TR EE IR SN . ek 8, il 2.
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FIGURE 4-8: WINDOWS 2000 NEW HARDWARE
WIZARD - 2

Found Mew Hardware Wizard

Install Hardware Device Drivers o
A device driver iz a sofbware program that enables a hardware device to work weith
ah operating systenm,

Thiz wizard will complete the install ation far this dewice:

@ USE Device

o device_ dri'\-'n_ar iz & software program that makes a_hald_ware device vaork. Windows
_needs c_Irl\.-'er _flles for your new device. To lozate diver files and complete the
inztallation click. Mewxt.

What do you want the wizand to do?

i+ iSearch for & suitable driver For my device [recommendedE

™ Display a list of the knawn divers For bhis device sothat | can choose a specific
driver

< Back I Mext » I Cancel

433 B3

AR AE FRVE 5 2 W B AT DAk BB w Bl EE 0K SO A
A IEHERRIE R, bR T IR IR e B RIS —A>, IEEREAE”, Ra
mdi R

VR WA NP B A R ILEGR T INF B IR SO,
SOPIR 2, P RoRCAIRE IR . R B ) R R X
I o o B 2 BT AL A RN HE SRV ¢ T AR EILINF SO %
1. — BIXA AL S, i OK gREk 22,
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FIGURE 4-9: WINDOWS 2000 NEW HARDWARE
WIZARD - 3

Found Mew Hardw are Wizard

Locate Driver Files o
“w' here do wou want \windows ba search for driver files™?

Search for diiver files For the following hardware device:

@ 1SE Device

Thie wizard zearches for suitable drivers in it driver databaze on pour computer and in
any of the following optional search locations that wou specify,

Ton start the search, click Mest. If you are searching on a foppy disk or CO-RBOM drive,
inzert the loppy disk or CO before clicking Next.

Optional search locations:

[" CDROM dives
¥ Specity a location
[ Microsoft windoe s U pdate

< Back I Mesxt » I LCanicel

434 PB4
FERRAC" 5 DU 7S ST G 06 DX 3 AN e 2% BBl SO IR s A2, (AT LABEN
FEAE, A A A AT R). Rl R T, XN R AR A
C:\Program Files\MPLAB IDE\Drivers2000\ICD2_USB
XA AR AL T SCAT:
* ICD2W2K.INF
* ICD2W2K.SYS
* ICD2W2K L.SYS
—Higiegdng, siidi OK.
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FIGURE 4-10: WINDOWS 2000 NEW HARDWARE
WIZARD - 4

Found New Hardware Wizard X|

Irsert the manufacturer's installation disk into the drive e |
= selected, and then click OF.

Cancel |

Copy manufacturer's files from;

|E: “Priogram Files\WPLAR 1D E\Drivers2000MCDZ_L ﬂ

435 SE,S
N AXEHEN s 8] S AE B — PR E AL BRI — DA IS, A
i b2 gk4t.
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FIGURE 4-11: WINDOWS 2000 NEW HARDWARE
WIZARD - 5

Found Mew Hardware Wizard

Driwer Files Search Results o
The wizard haz finished searching for diver files for pour hardware device.

The wizard found a driver for the following device:

@ LISE Device

Windows found a driver fior this device. To install the driver Windows found., click Nest.

= c:vprogram fileshmplab idedrivers20004cd2_usbhicd2w2k inf

Cancel

436 &6
I —ANGHEHE N % 77 "Microchip MPLAB ICD Firmware Loader”
eI, IRk A, RN
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FIGURE 4-12: WINDOWS 2000 NEW HARDWARE
WIZARD - 6

Found New Hardware Yfizard

Driver Files Search Results Py
The wizard has finished zearching for drivesr fies For your hardware device,

The wizard found a driver For the following dewice:

@ USE Device

‘windows Found a driver for this device. To install the driver Windows: found. click Mexst.

= c:yprograrn filesmplab idehdrivers20004cd2_usbhicd 22k inf

Cangel I

5 —ANHEHER S 7"Microchip MPLAB ICD2 Firmware Loader”
Weizde, BATRBOIRE, R e k.

X MCD2 £ PRI 2. RGN 1% H 38\ MCD2 USB & /iy
UK. LEHIRERE S 3K 5 — AN ARET, T 5 5 DUD A R R 4%
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FIGURE 4-13: WINDOWS 2000 NEW HARDWARE
WIZARD -7

Found Mew Hardwara Wizard

Completing the Found New
Hardware Wizard

_\> Ficrochip MPLAB ICD 2 Firmware Loader

Windowz hag finished instaling the zoftware far thiz device.

Ta close this wizard, click Finish.

£ Bk [Cancel

4.4 WINDOWS XP %%
441 SE1

KT USB #4423 Windows XP RGN, — AN iHHE
SRR ARG T — B A . U RT BE B — XA
B B P IEAE R T R

REERHTHE I L 5, 2 o AU AR 1) 0 AR AE. B8 AR
B LB R () w2 D AR 2,

37

PDF SCHFAi ] "pdfFactory Pro™ X AL www. Fineprint.com.cn



http://www.pic16.com
http://www.fineprint.com.cn

PIC16-MCD2 1% H i3t B 43 http://www.pic16.com

FIGURE 4-14: WINDOWS XP NEW HARDWARE
WIZARD -1

Found New Hardware Wizard

Welcome to the Found New
Hardware Wizard

Thiz wizard helps you install sofbware for:

USE Dewvice

\) If your hardware came with an installation CD
2 or Hoppy disk. insert it now.

‘what do you want the wizard to do?

 Install the software automatically [Recommended)

& Install from a list or specific location [Advanced]

Click Mext to contirue.

¢ Back I Ment > I Cancel

442 B2

TN R AR IR S . Rk . ANELE R R R BRI AR, dkrp
EHRPUFEXAALE”. W% MPLAB IDE %% H 3%, ®&F T H%
DriversXP\ICD2_USB. fiili F—b.

e B R rh, — AN REHE S SRR R AR A XA A 22 BE R A R
I Windows (PR, s AThsR 445,

FER: WERLE R PR B RILER] INF 5508 45 0K ) S,
T 2, WHAEER, H AR RE AT .
N BN AZ U R B BN R BT AR B, RS AR
—b. (ETEBRR A IREN. . T, SRR, e L. B RS AE
FEVFERETT AR ELINF SCHF) 442, 350 MPLAB IDE %238 H s), %
7 H 3% DriversXP\ICD2_USB. — HiXAMRAR LSS, i OK 4k

e oH:

ST
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FIGURE 4-15: WINDOWS XP NEW HARDWARE
WIZARD - 2

Please choose your search and installation options. :5

%' Search for the best diver in these locations.

Uze the check boxes below ta limit or expand the default search, which includes local
paths and removable media. The best diver Faund will be installed.

[ Search removable media (floppy, CO-ROR...)

¥ Include this location in the search:
|E:\ngram FilexsMPLAR IDEAD ivarPuWCD2 1JSE ﬂ Browse |

 Dion't search. | will choose the driver to install

Chioose this option to select the device driver from a list. Windows does not guarantes that
the driver you choose will be the best match For pour hardware.

¢ Back I ek 3 I Canicel

443 BB 3
— H. Microchip MPLAB ICD2 [Fl {4 N\ #s#l 2e2, “5¢ it i BT hi -
S S B e gl e, IR 25 7 i ) 2 2.
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FIGURE 4-16: WINDOWS XP NEW HARDWARE
WIZARD -3

Found New Hardware Wizard

Completing the Found New
Hardware Wizard

The wizard has finished instaling the softvars for

@ Micrachip MPLAB ICD 2 Fimware Loader

Click Firish to close the vaizard.

< Black I Firigh I Cateel

4.44 HB 4
AN TR AR IR AR G e AN IR Ve, JFLBI AR T —
AN R RE A B 4

FEIXASSPIEHE IS, AIF R 7] T 0 UG HE 23 TR 7. IR K 22
%¢ Microchip MPLAB ICD2 [l % F iy, &8 WFIEK 85 E AL E (),
RIG Rl N ke d
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FIGURE 4-17: WINDOWS XP NEW HARDWARE
WIZARD - 4

Found New Hardware Wizard

Welcome to the Found New
Hardware Wizard

Thig wizard helps you install software for:

Micrachip MPLAE | CD 2 Firreware Cliert

I.'.-) If your hardware came with an ingtallation CD
S or floppy disk. insert it now.

“what do wou want the wizard to da?

7 Install the software automatically [FRecommende d)

' Ingtall from a lisk or specific location [@dvanced)

Click Mext to contirue.

< Hauk I Mext > I Cancel

445 WE,S

N R AR IR Sk . A B RE R TR R AR,
EHZ P AR IXALE”, W MPLAB IDE 223 H a5, k81 HF*
DriversXP\ICD2_USB. i K3

1E B R, *AﬁﬁﬁAﬁﬁhT”%ﬁﬁA@#ﬁ & R AR
I Windows A", s R gk 4k,
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FIGURE 4-18: WINDOWS XP NEW HARDWARE
WIZARD -5

Please choose your search and installation options. .

@ Searchfor tha best driver in these locations.

Llze the check boxes below to limit or expand the defaull search, which ncludes local
pathe and removable media. The best diver found will be inztalled.

[~ Search remavable media [floppy. CO-ROM.. |

¥ Include thislocation inthe ssarch
|E;\F'rcgram Files\PLAB 1DEND mveersXPACDZ_USE j Biowse I

™ Don't search. | will chocse the driver to hetall

Choaose this option ta select the device driver fram a list. “Windows does not guarartee that
the driver you chooze wil be the bezt mateh for pour hardware

< Back I Mext > I Cancel

446 BB 6
— H. Microchip MPLAB ICD2 [iil % = by 4% 42 26¢, “ 5 Bt R DB il A
) R L. AU SE A R USB 2k,
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FIGURE 4-19: WINDOWS XP NEW HARDWARE
WIZARD - 6

Found New Hardware YWizard

Completing the Found New
Hardware Wizard

The wizard haz finizhed inztaling the zofuane for

@ Micrachip MFLAB ICD 2 Frmevans Chent

Click Finizh to cloze the wizard,

¢ Back | Firish | Cancel

FHE HEISH

5.1 HiIR ke B2 4 o7 b 22

i1 77 MPLAB IDE, MCD2 (mplab-icd2) A1 PIC &5 L H kr N
H AR Z R ZZ AR RERZ I MCD2 [WIE #8147, T AEEf#/E MCD2 1) he%tE
HH )R — BRI A A AR L ).

5-1 J& WoRSAEER I —AMHER]. 2 MCD2 e fifik, &F—A>
FERA A T AR IE 5 X — e T I S e DL Bl R IRME 2 e
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FIGURE 5-1: CHAIN OF MPLAB ICD 2 FUNCTIONALITY

PC to MPLAB ICD 2
MPLAE‘. ICD 2 Target
MPLAB ICD 2 ‘ Firmware to Target P?:Ergr
Communication — PIlecro MCU

In-Circuit o Debug Application A
Debug Resources [ noig Regisors \'

5.1.1 ¥ PC 5 MCD2 KB R

X —FEE T TREB GRS, W E A TAE, H KIS 3 MPLAB
IDE @ IHIPAE . il MPLAB USB IKsh# E#i 11«34, &G WINDOWS
T4 B B G HE () USB #54), & MCD2 BXEh & 77 IE i il 225 31 PC L.
WA RS-232, #fiiAfE COM IKBXFUFHEH FIFO L&l 5G], I Hi
BRIV E AR, 1% MCD2 USB 3RS £ 1 41455 3 25 1) USB #4>
ANATIL, #EAF] MPLAB IDE %3642, 1 FF\DriversXXX SCAFJE(XXX %f
MEEAE RS, B 98, NT, XP &%), AN AT IF.HTM SO, A AH Y #
YERG IRl 54115, B2 USB 22341151 & G S DU 5.
5.1.2 4%#: MCD2 [E

fIN{E MCD2(MPLAB-ICD2) 1 & N T S8t hig 1 [l 4. 58 i [l 4 ]
LUl MPLAB IDE K T 8. Eedthi AR 6 58 A Microchip
i N

[ £F B RRAS B vk 52 W 88 PIC B LB S REL o T [ AR
MCD2(MPLAB-ICD2) 58 {7 &, 1% i H README (4.
5.1.3 8 MCD2 83| Bz PIC B 5L

TN TR HR IE WA %S, I HAE VPP, PGC M1 PGD ¥ He s S
B MCD2 554 T30, % MCD2 (#) VDD F1 VSS A3 #%5) H
FrELE A, BOBANAE TAE. 24 MCD2 Rt gy H AR Bk Ny, & hsift
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VDD 2| H#7(<200mA, X[ 5V)Fx Lebiyth g2 vt 0, Hbx VDD K
{fH. VDD # MCD2 Jg&5, DRI R 2 5 15, A CH 5 VDD fiLH fit
VA 25 20 4 3 31 H AR L RIZ AT, %HF MCD2(MPLAB ICD2) N 2% i
FEL % 119 155 4 PRI 1] B-2 TR,

FIGURE 5-2: MPLAB ICD 2 INTERNAL BUFFER
CIRCUITS

Target VDD
(to pin 2 of
the ICD

Connector)

To PGC

To PGD

WA MCD2 7E'& 1) VDD £ B, e ARz T. 24 PGC
PGD i@ i, WA EATE IS S, LGS H bR\ VDD 2] VSS 1% B
A AR HAT IOERAE, VPP N /R+12,4+5 F1 OV. H A5 7E M MPLAB
FIEEOHAT MCD2 Zhig 2 )i, fEMBLest A Re R RIS, &0, Xeeigsd
5.1.4 #¥: BirHIE

MCD2 fi¢ £t H ¥ PIC 2 7 LK) VDD £y 2V 45 5.5V [TEHI N TAE. [
M Zimst e 3 AL, i, MCD2 L PGC #il PGD 1/0 B
2% W H Fr VDD e fit By 1.

5.1.5 ##: BRIRG%

Mg — AR, AT E AT IR G AR, (IR
REXFANAE T1E, E2H IR 8 % T/E. RNMREL B, i,
MCD2 %k H#x PIC # / HLIZAT.

BRIN H A R IEHMIATIR A, W20 20, g, g— N/ e
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FPik LED NER, SRJ5 95 MCD2 FIHRIhRE, R L8 H s PIC ¥
L.

Wi T MCD2 31847 H . WS LED ANER, Kl bl R B A4
ATAE. W RAE R IR SIS BL T X H brgefhdn s fE, MCD2 {54%
WokEEE, MPLAB el AL, an e e fisfrHik 5 MCD2 4k
({fEi£F% Debugger>Run 2 J&), B4 HIERTREA 8. {F Rk s A E
PGC, PGD F1 VPP. ffiih4ii % Ja 2l is. w435 45 J3 2 il id K,
MCD2 Ky, Jfes iz

A W IE B 1 iR 3 % 4 20 B % 8 (8 B Configure>Configurations
Bits) . 4% # B ACK AR IR 5 g AR B, X AN iR HS B, T
AN/ AR g8, 228 RC A, XL & 0T R &% v nl RE e 2 AL,
HEATRRA Y LT 20, AR E 74 % & I8 U sl 455
T, I asniedT ] Ll OSC2 SkAd A
5.1.6 4 NARE

FRK: MCD2 IEMI4aAE, 1l LLUEAT LED HAKAT AL, Bidnfs
ISR Hbras . FEgFEZ 5 MCD2 K87 — M Thae, LARIA Hbx
PIC #)5 WL i %dls 5 MPLAB (1) R 7 17 fik 28 AHUC fC .t m] DLk 4%
Programmer>Verify K31 L4 HAx PIC f7ff#s5 MPLAB IDE [1JF2
Fe. Wi HFR PIC B HLAT AVDD 1 AVSS, il eA TR EffiER:, X
1 Y 28 1R I PR3 2 3] L 5 (VDD) R HE(VSS). B 22 40 15 1 2 % SR 50
Tt AL T A BE RS, MCD2 K ARRE T AR, #fiiAE
Hi s 4 P48k 5% P41 (Config>Configuration Bits...).

5.1.7 ##&: ARAPITRE

4 )\ MPLAB IDE 1§/l Debugger>Program Zifig, kAT 53
TE, EHFE PIC BN R S AR R A . AT RN
SRR S e MRS ORI B, TN R R, 24 M G R A% 52 K i
PRI MCD2 1E R iRAS), TRPATAID A N3, LI 47
K A AL RE.

i A Config>Configuration Bits... ¢ ik, &tk € MPLAB
SETPRE R RIS, S A7"Background Debug #{fifiE, 4
BTG FE I PR PAT AR 4 R 2

46

PDF SCH{#i ] "pdfFactory Pro" X Hfix A ww.fineprint.com.cn



http://www.pic16.com
http://www.fineprint.com.cn

PIC16-MCD2 1 F i B 45 http://www.pic16.com

5.1.8 ¥ ELAATAH

NAEGMFEZ 1T, 76 MPLAB Hift) MCD2 _Lifik phfiegi i ag. i 2
% Config>Configuration Bits... SJiGHE, ‘& BERSHAE Lk R 2 A7 2 A
fig. #brid "Background Debug” (1] 1T IV %! 7~ "Enabled”. 2 %2 M. 1% A
Debug ¥ H.10E1T, MAJE Programmer SZI.
5.1.9 ##: FELRARXEHE

TEAEEEH B b A5 5 S0 e — 38R R 8 (R 27 4745, 4% MCD2 R
(R SC A 5 A7 A B RE P AT A AN BEAE . SR oo Ikr BRI 34 S0
(BTFLUTEH), A, BRARRIR SRS 5, 1K 8 PR bR 1 o R B
I B ASBEAE N A . SRR g B B, AR
CBLOCK ik EQU F TAZ H 1K /7 s, i\ MCD2 R [ 75 77 25 B Bl A .
WA AR B R AR B AT B, R E T I E I B IS AT, BRIk
A A T O A B A IERA AR, e AR AN TR, i AR
PR e CALL FAST 354, MCD2 1§ ] T 5% 1 Hikk, B ASHE bR
IR ek CALL FAST ZhAEIERIIE H.

b M =

FRE  EREHE

X R B L L ]
6.1.1 NAATRIN Z G g B ml R 56 2
6.1.2 It AFRFTE ICD KiE L #45?
6.1.3 JTAAEERS MCD2. BlERIZEAM?
6.1.4 MCD2 %" Target not in debug mode error.”, X4 & 2
6.1.5 MCD2 fE¥s H bras A L R ig 472
6.1.6 MCD2 S HHIK HL e i M5 (LVP) 2
6.1.7 MIKALE PLL ka0, At Al #? MCD2 #4:i.
6.1.8 ML ALK, Mt A WREh Ik R, R R AEAEIK B SO e
FRIEAT, HHIE IS ) T ) E A S
6.1.9 FLAEMH ] MCD2 ALY 42
6.1.10 MCD2 J& Wifi] &b BEAZ B0 44 112
6.1.11 A4 FRMIL EEDATA X IR AFHE 5 K {E 2
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6.1.12 414 ”Erase All Before Programming”2s i /& {42
6.1.13 W AE MCD2i%EH;, FIFEFHe M PORTB 8t GPIO AT A1
1125?
6.1.14 MHPIEATH, KA A g RIS T AN IER?
6.1.15 4Tl PIC12F629/675 i PIC16F630/676 i, Afl4&Ag#d:
FEE1R?
6.1.16 4 K ZE S YA LED INKR?
6.1.17 MCD2 H A ffeeft4?
6.1.18 7t RETFIE #54fHmItegeh sy, hit4 W,STATUS A
BSR 7 fran s i L?
6.1.19 YIRAER IR T GG B W E — WS, A e s e
1 0001, TfiANJE 00007
6.1.20 A AR I AE it % W os A B R B ?
6.1.21 MBI TR I, BRI E I AT, (EOR AT AR e i s
W 7 A AT ?

6.1.1 [: RARKRGHE R LR ?
A H IR T TR RS PGC, PGD Ml VPP 344, #iil HFx PIC
FAUE SR, i H bR PIC 3 HLA AVSS Fil AVPP 51, 151X 1L
o | TS L A ) i .
6.1.2 j]: A ARFENEKERIE?
Ze 0T MCD2 SCREPME S B2, WiRAE ko | v (R v, A
BAREA A . WA —F, 0T 8 BIIasfF, 6 A 110 #2k 3L
3 AN, XEAREHHESZN. EXANRE, A= TRIRM PIC By pLidE
—ANIE R SR A FUX AR S | A B 4. 00K AVRAE H AR A A
5 . X Bk BRI PIC B ML AT 7R 2@ 5 |5 MCD2 #:11.
KR SU2 nT ELE MCD2 AT IS DB 28 KT . i S aX
e RPN BE IS MCD2 R . 31X 65 (1) PIC 5 3 ML LT B 2%
B R EANTRESC A I — AN S ZEIE L Sk A Bk Sk fic B 0 A ADC L
FHRG T R AT, X L5 | ) e AE e il MCD2 W72k B 3ok g,
DIVEFEAE HbR N TR LS — > ICD2 82 RE, KiXsege: ) VPP, PGC
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FI PGD % .
6.1.3 [: BAREERES MCD2. MAERZEBAM?
% MCD2 [PHLRAT 58 T2 KOG Nzl mise. W LRIG IR, nlhE
A HEET USB, HITRET ZEHE— 1 HYE. RS-232 EHEARES
MCD2 fltHL, R, A4 USB ASREFe iR, £ X M iR e R & F/ 17
. USB MK 5 %35 2 A 1IEA? MCD2 USB 3K4) WV iZAE WINDOWS
PR BRESTIEHE P N iZ AT LLE £, —48 USB 488 A fe WAV I USB
WAL YR, AT X e dsn, FE S MCD2 &,

FIGURE61:  SYSTEM PROPERTIES DIALOG
SR A=

rmd NrownPwar | Wy doan Zuile | Fodn s

B oUponnbo w7 AR ey e

1] g MERELTED W cThil ﬂ

W e e

B Bamwden:

o ksl Ge W e erem:
AT TREEFFT 0 IER | sdHas Do [
sk U ET T 2T e i
e - T

| o i Liwy | Lot I %4 |

[ ] it

6.1.4 Ji: MCD2 W% Target not in debug mode error.”, IXE R4

y=¥i5 ¥4

% W IXEARA MCD2 ARES TR Pl R, ZUE R PBUTRE P

#H3 Hbr PIC B4 HL, HAEET Debugger>Program i # ik £k g fe

A I 1 B R R BOR AT R AN R TR, 0 E b i sl rLYE )

] . A A i CE 47, & “Background Debug’ & 15 # AL e . A E

Config>Configuration Bits..., #iiAF& | 150 i 2847 5], RS- B

KA, P o e B .

6.1.5 ji]: MCD2 g&¥ B #r 28 L B EE T 247152

% fie. HELHBR PIC B MISCRHR IS AT, Bt RRISITEL 2V MK

JEF. 7 MCD2 [ N e rhas i, A g ds. eI H bras
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PEM¥) VDD SkAibHs. JFH, MCD2 KR H Args tE I/ s s, JF IE a1 i

B DR LA AR BOX — #RAE, R IE @ FLASH ¥R 8%, 17

MCD2"Settings"*1 G HEH, VDD 75k $"From Target”, J+H.7E H AR

A AN TR R IZAT.

6.1.6 |i: MCD2 XK EHRES(LVP)?

% ANRE. HIXIFA R Y HEr 28247 /CH s VDD e ANREIE R

TAE. & R R INE] VPP ()4 H s S 2 +13V.

6.1.7 1: HRME PLL RGN, I 2HILEE? MCD2 #iH:E.

% I PIC B HLI— N EK. 7EK I B RS PLL k8, HIRTE

BIRG I TT AR5 P 20 H ARAR . W R, HER PIC B WA

A B, BT, U ANRE TAE. [FRE, WURAEDI#3] PLL B

I PR AT B T T R0 8, 2RI Re S is AT, (M PLL.

6.1.8 [l: HRLZERIN, A TAWINTLERE, RERBAERS) M

K ERBEA, I HIRKE WS [0 F48 7 £ 4 B 022

Zer Rl RX A )R, R DA OK A 2 e 1) e, N A TR 1) 0

. ERGHRBEE G, A, WAEALEET RGERFEA,

MUNFFR P PEEAE", ARG ERE” B AT BRI HIAR", 0 3¢

PR, HENB IR SCHEIE, IR IE A 1 IR E).

6.1.9 j: RAEFH MCD2 MRS R 2

Zrr ANRE. AIDERY, 5 0] A P A At 2 A AT DX IR ) 2 S R4 4 BHL

1 MCD2 IEH 1 TAE. 448 F MCD2 347 I, ANEAd B AR AT AR i

PR IR E WA, SR — A B TR, AT DA AR fR

¥,

6.1.10 [a: MCD2 &t {a] &b BRI 45 ) 2

% ER ALY, fE MCD2 HEATHERR, gmfE RRERER, T AT

fitg 25 PIC B8P BLASE FH 114 FH A S0 B P AT A (L A4 3 HH AR A7, BT A

AT BT R AE R R X — £l

6.1.11 Ja: RHH2AFRMBERK EEDATA XIRIRE4LE R K(E?

% MCD2 fiE 421 EEDATA X1, MiANT; 21T EECON A7 Bk

ff) TABLRD $54 5. MPLAB i F (2 b3 A If 230 H - 4R, 24

FODPATAID IS, N3k Gk [ D)3 WRR P54 £1) MCD2 52 EEDATA X
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15,
6.1.12 |: K4 Erase All Before Programming”28 gl /K 4,2
o AR BB FLASH #80Frh, Sfesdyl 2 sk AEAR AT I R e A0 28 X
4% bank B e, ST IX e, (EGNREZ BT T AT A% D Pl 45 .
6.1.13 : WEARE MCD2 &R, RKFEFEM PORTB B GPIO ¥E4Tik
MEG?
e fig. YR AT REg A RE N, PGC A1 PGD & MCD2 181, M
PORTB *f H P AR AT ey A2 240, &, M PGC 1 PGD
BEIMEA = E B, SFIX A5 ) S B VE e 2. 534, i
PORTB I F-AR Ak Hr ki i A i, PGC Fll PGD L1155 K AN RE 7 24 v .
6.1.14 Ji: HHPBITH, IT4RMIEITAIERE?
e I RAE AR IR — AN B AR S B 2 R PR T R
BAT, fEIRPAT L IZ AT, i 28 S RFELiEtT, BIAEH /- R
(PR 4 L
6.1.15 Ja:243R{FH PIC12F629/675 Bk PIC16F630/676 I, R4 Lf
5 MER?
2 4] MCD2 I, JXUS 3R GPL/RAL 5 IAGES b . T Fx
XA MCD2 I 245 8., 1E22% microchip [¥) MPLAB ICD2 i&fid
3L R%(DS51292).
6.1.16 : fH-4FFESHFEBRIFEFMIT LED NER?
% AT RER RN H AR MCD2 H: 23k MR LR 7 A K (5 B2 HE 1 5 170 4H %),
KRR MCD2 B R oG, NI IR 2R B br bl Sz
o P ARG HL VR AT LEDS (HL 5 ] R — & ).
« PUT—i"Self Test”, AEMCLR=VPP | {1455 (e BT il n] /g
o im ).
o A H bR GRS B EEYE E, PAT— kAR, 7E51L(VPP) [7-8V
(1) PR S S5 KR
VR, R H AR PR, MCD2 £ 5 F K BELLE X BB R
2 HARSS LR, Ni%E BIIE R R
6.1.17 j&: MCD2 H K fit2et4 2
% FEHfiE MCD2 BBl H bR ey i By, F A 2 1R AT .
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Target VDD
W EPRE T "Power from ICD2", ¥ MCD2( M fig 4 5V)#&4L(¥) VDD.
WK k" Power from target”, W IR H AR (2 3] 6V)42 4Lt

VDD.
JH IR AR AL
00=i it VDD fEf5 & JE 2 N

1= /MR VDD & -5 € el
80=1p K% VDD & T i H
SR A HE B 7 AN T A 1) L 05 L

B vPP

EGnFERFE R, MR MCD2 #2445 Hbs VPP/IMCLR 5|1 4w e i
(VPP).

JH s /R AR

00=if it VPP frfa e a2z N

O1=ip /Ml i VPP & T Ju
80=f KA VPP & T4 5 i [
IR R R H bR VPP/IMCLR 5| 464 IE 1.
MCLR=GND
Mk MCD2 #2455 47 HLH 45 HAx VPPIMCLR 51 T H AR S A7 1 g
JH s /R AR
00=3 it HiBESR LS H AR VPP/IMCLR 5| i
80=1 N ix Hiu L FE X T VPP/MCLR 5 IR &
IR R R H bR VPP/IMCLR 5| 46 A IE 1.
MCLR=VDD
PRRAE IE S Ve A b (W Run’)MCD2 #2441 VDD %5 H b5 VPP/MCLR 5| JiiI
(1 fE
JH s /R AR
00=3 it VDD fig#Ait4y HFx VPP/MCLR 5|
O1=ip /Ml i VDD %F H¥xr VPP/MCLR 5[ I
80=1 N ix VDD X H¥r VPPIMCLR 5K =
R B R R R ) PR A
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MCLR=VPP
MR i #E ik F b MCD2 4241t VPP 45 H A% VPP/MCLR 5111 g
JH s /R AR

00=3 it VPP fefefites HAx VPP/MCLR 5] JiI

O1=ip /Ml i VPP X} T H#» VPP/MCLR 5 I A

80=1 N ix VPP 5t H¥x VPPIMCLR 51K =

AR LR H bR VPP/MCLR 5| I A .

6.1.18 |a: &7 RETFIE $5&-fFF=LEH T MR, IH4 W,STATUS
M BSR HABRESHAR?

%+ CALL FAST FUH T =L Ae g b W (15 + S A7 as g MCD2 fi ] 7. 1X 2
XFT MCD2 #AE 0k B B8R, WU i B A CALL FAST #1237, 5
RN AL P W IR 45 FE ikt RETURN FAST sk RETFIE $54
R T oA, a2 i 3] n) .

6.1.19 M: JRARMBIFHNEBMERE AN, AtABEIR
FEHHE 0001, AN 00007

% MCD2 {5 1EAEWT i 2 JE IFR 4. IXFKon e EE 0000 KT s 2 45 40T,
SR 24 AF— AW TR P B R 3 ik 0001, Qi SR - FREAE
AATARAD (1) 58— 4 i 2 Ab A5 1, AR AT 20 7E ki 0000 JiUE —4% NOP.
6.1.20 : A4 R BAF L BRI EERE?

% MPLAB IDE BRI 2B 2. B WX S/ B fE,
ZiUfFH MCD2 BT — IR B 154

6.1.21 [a: ZHHPBITAEE, REERNSITHRNRE, B4R 2R
BHWEFEEIIT?

% MHOPIEATRE, LIRSS A RV PIC B AL R AT, Wi iy
RS WEE DR S ol T |79 S e p S O B TV YR 22l S |
WA, v DA B IR S5 R T — N OIS AT, IR R AR
W7 J 33 N KT
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